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WHAT IS DIGITALE?

Digitale is a means of expressing ourselves that is both suitable to all and easy to adopt. It is
a personal video that lasts max. a couple of minutes, and a minimum requirement is a
computer. Usually the video includes a text written and read out loud by the filmmaker,
illustrated with personal photographs or drawings. It may also contain music that is either
composed by the filmmaker themselves or not copyrighted.

Originally digitale was used in telling personal stories but this flexible method may also be
applied to new purposes, such as strengthening social involvement or to social influencing in
for example social work and libraries. Teachers may use digitale in order to empower their
students and improve their media skills. However, it is important to define the limits for the
subject beforehand; watching stories lasting over three minutes could easily be quite a boring
experience for the viewer.

Examples can be found online: The Center for Digital Storytelling community
(www.storycenter.org), the European Digitales project (www.digi-tales.org) and the own
pages of the Medios project (medios.metropolia.fi).

DIGITALE PROJECT

The digitale course is a cinematic story workshop, where a 1-3-minute film is made by
combining pictures and narration. Usually each participant makes their own stories by using
either personal photographs or new photographs taken during the course. Of course, digitale
may also be conducted in pairs or groups, for example as a project for a certain subject. The
course lasts an average of 2-3 days. The course may also be spaced over a longer period of
time, for example into 6 three-hour periods.

During the project:

- Atopic for the story is determined and a script + potential storyboard are written

- Photographs are compiled or taken, drawings or other illustrations are made, and they
are transferred into a computer

- Voiceovers are recorded

- The pictures and sound are transferred into the editing program and the film is worked
on

- The finished film is saved on a CD / DVD / flash drive

The objectives of the course:
- Empowerment
- Finding personal strengths
- Developing narrative skills
- Learning cinematic expression / media skills
- Developing technical skills
- Learning new skills and transmitting them onwards via the means of audio-visual
narration

Technology (these will allow you to cope well but even less is enough):
- Computer with an editing software, e.g. Windows Movie Maker
- Microphone / digital Dictaphone
- Digital still camera
- Scanner
- Flash drive



THE COURSE OF THE PROJECT

The instructor of the digitale workshop should determine the schedule for the project in detail
prior to the beginning of the project. During the first meeting, the topic for digitale is
considered and designed. Enough time should be reserved for writing the script, especially if
the process is new to the participants. On the second day of the course the group members
will bring photographs with them and voiceovers are recorded. The pictures and sound files
will be transferred into a computer, after which the film can be worked on with editing
software. On the third day of the course, the films are finished and filed. Finished films are
viewed together and feedback discussions are conducted.

DESIGNING

Before beginning to work with the digitale, it is important to create an atmosphere where it is
safe for the group members to generate stories. Take a moment for storytelling exercises, get
lost in the world of stories, awaken creativity with for example the following exercises:

- llove/hate: within a minute, each participant writes a list of things they hate on the left
side of a paper and a list of things they love on the right side. The instructor will ask
each participant in turn to tell what they have written down. The group will then discuss
the story topics arising out of these things.

- Theturning point of my life: Which event/moment/experience changed my life or
affected me greatly. Write it down and share with others if you want to.

- Ball of yarn: The instructor will throw the ball of yarn to each member in turn, at the
same time holding on to the end of the yarn. When holding the ball of yarn, each
person must state their name and one thing they like. The person having received the
ball of yarn will hold on to the yarn and toss the ball to another person. This way the
ball of yarn will eventually form a web. When tracing back the web, gathering the yarn
back into the ball, each group member will, in their turn, state a thing they don't like.

- Story in a circle: The instructor will ask the group members to name a location, color
and situation. The story will be formed in a circle so that each person may only say
one word. The pre-defined elements must appear in the story. In case the story starts
jamming, the instructor may carry the story forward by saying: And as a result... And
in the end... And this tells us that...

- Matches: The instructor will give each person a match. In turn, each group member
will tell a story about a matter important to them but they only have as much time as it
takes for the match to burn out.

SCRIPT

After the story exercises, move on to the script phase. In other words, the script is the
voiceover that carries the story forward with the photographs. Prior to recording the
voiceover, it is good to read the script out loud either alone or in a group in order to check the
duration and narration. The printed script should be brought along to the voiceover recording.
During the script phase, it is important to take into consideration the following things:

- Think in advance whether you want your story to be published (and where it could be
published) or whether it is for your personal purposes only. You can also consider the
publishing issue even after the completion of the digitale.



- How many topic-related photographs you have/how easily you can take the
photographs related to the topic or more photographs

- The duration of one picture in the story should be about 3-7 seconds: in less than 3
seconds, the eye of the viewer does not have enough time register the image, and
over 7 seconds easily becomes boring for the viewer. Of course, the same photograph
may be used twice in the story, cropped differently, if this serves the purposes of the
story.

- The goal is to create a story that lasts 1-3 minutes. When you have finished the text,
read it out loud and time it. This way you will see in advance approximately how long
the story is going to be. Remember that in the finished film potential pauses, as well as
opening and final credits, will lengthen the total duration.

STORYBOARD

Once you have finished the text, it is time to consider the pictures. You may already have
photographs or drawings for your story, or you might want to take more photographs. It is
also possible that you don’t know how to illustrate your story. A good tool prior to compiling
the story is a storyboard.

What is a storyboard?

A storyboard is the graphic representation of your story. It combines the script and the
pictures you have selected to illustrate the story. In its simplest form, you can write the
sentences of the script on separate slips and then attach the appropriate photograph to each
sentence. This way you can place your story in a chronological order and see the suitable
places for the pictures. You will also see if you need more pictures or if some pictures aren’t
necessary. At this stage, you may also easily change the order of the sentences or pictures.

Storyboards may look very different. The pictures may be drawn or photographs, they can be
placed vertically or horizontally, the text may be placed underneath, on top or to the side. The
most important aspect is that the story travels chronologically from the beginning to the end,
and that the maker themselves understands the markings and gains the necessary benefits.

In addition to pictures, it is good to mark other aspects important to the finished story in the
storyboard, such as music, cuts for the pictures, and potential picture effects. This isn’t
necessary but it helps editing the material.

Example of a storyboard

The page below is a part of the storyboard of a digital story called “Patkaty6lainen”, made by
Jyrki Kaheinen on Windows Movie Maker.

The story does not include music, so it is not marked in the storyboard; however, in case you
use music in your story, mark it on its own track on the right places in the script. Music may
be used in digitale made with Movie Maker but it can only be placed in spots where there is
not speech, since there is only one audio track that can be used.

The example storyboard was created in the regular order; i.e. first there was the completed
script, which needed illustrations.



— The first picture in the

” m—— example, the rock, was

- | chosen to represent stability
EFEKTIT L e—— - according to the text. It is
KERTOJANAANI Halusin vihdom jotain pysyvampai ja hankin itsellent ammatin. One Of the rOCk phOtOgraphS

taken especially for the story
and it turned out to be the
best one. The next picture is
, also adapted to the text; the
- diploma is supposed to
rrosormus ‘"‘wm"s_”m‘"’ communicate that a
sisilava profession has been
acquired via education and a
job comes after it. The
MUSIRKE i usiakkia cropping is tight not only in
order to not reveal anything
too personal but also in order to crop out everything that is unnecessary for the visual image.
The heading of the diploma communicates the essential.
The lens of a camera was chosen to represent a job. Originally the purpose was to place, for
example, a facade photograph of the workplace at the same spot but the plan was changed
since they preferred not to reveal the place of work. However, the picture gives the viewer a
hint on the flmmaker’s profession.

MUSIIKKI ei musitkkia

KUVAT

EFEKTIT

KERTOJANAANT Sain myds tyépaikan. Nyt olen tydskennellyt samassa tydpaikassa kunsi vuotta.

The idea of using employment contracts as illustration was there already at the script stage
but privacy protection was considered a problem. Contracts are confidential and all
information should not be shown; the solution was extremely tight cropping, leaving only the
neutral material visible. As a result, only the word ‘tyésopimus’ was visible and in some
pictures even the one word was only partially shown. The cropping also forced the filmmaker
to consider the placement and continuity of the pictures, resulting in the decision to use ever
closer pictures, to leave parts of the words out, and to use unsharpness as an effect. The
goal was to bring forth the large number of employment contracts, even though the job
remained the same. The unsharpness symbolizes the fact that prolonged temporary work
blurred the dream for a permanent job and turned temporary contracts into a normal practice.
As you can see, all effects are crossed over in the storyboard. This is because when
compiling the story, it was decided to leave them out. When making the storyboard, cross-
cutting seemed like a good solution but when compiling the story, direct cuts suited the story
better. This is also a good example of the functionality of the storyboard as a planning tool;
segments of the story may be added or rejected already at this stage. It is fast and easy.

Sometimes pictures need to be cropped for various reasons or even rejected altogether, and
new pictures need to be generated instead. This may annoy the filmmaker, especially if they
feel the pictures are good and usable as such, but for some reason they cannot be used.
However, the situation forces the filmmaker to reconsider the illustration and generate new
ideas to replace the original solution. Thus something better may be created than the original
alternative. This happened with our example story; special close-ups dictated by the situation
became the main theme for the picture narrative, supporting the personal topic of the story.
Remember that this is only one way of making a storyboard! The purpose of this example is
to help you understand what a storyboard is and what its benefits are. If you wish to
familiarize yourself with the topic in more detail, there are many good websites in the Internet



to read. Here are a few addresses: www.mediametka.fi, www.thestoryboardartist.com,
www.sotherden.com.

When planning the pictures, it should always be considered how widely the story will be
viewed. You can show more to your family than in the Internet. People often forget this and in
worst case scenarios, personal material is distributed around the world via the Internet, and it
can never be removed.

The storyboard does not have to be made on a computer! It may be written and drawn
by hand on blank or square-ruled paper.

GETTING TO KNOW THE EQUIPMENT AND SOFTWARE

After the script stage, it is good to go through the equipment and software that can be used
together with the group members. This improves the preconditions for independent work with
personal stories.

- The available image processing software (Paint, Photoshop, etc.) with which you can
make small changes in the pictures if necessary. E.g. cropping and reversing the
image.

- The available editing software (e.g. Windows Movie Maker, Avid, Adobe Premiere,
Final Cut Pro, iMovie)

- Available DVD burn software (e.g. DVDit. Note! With Nero you can only burn a
dataDVD, which cannot be played in DVD player)

- Scanner

- Arecording studio (a quiet and echo-free room) with sound recording equipment
(computer with a sound board and e.g. Windows Movie Maker, microphone, music
stand for the script or tape for attaching the text onto a wall)

- Camera and wires

Windows Movie Maker

Good software for learning editing is Windows Movie Maker. The software comes with the
Windows operating system and it is simple to use. Movie Maker only has one audio track and
image track for compiling your film. Prior to recording the voiceover, it is good to create your
own project in the Movie Maker: start the software and

a Click Start on the left bottom corner.

a Click All Programs and choose Windows Movie Maker.

a Create a New Project and save it in the My Film folder (see the creation of a folder on the
following page) as follows: File — New Project — Save Project As

Power Point

If you wish, you may also try the Power Point software that comes with the Office package in
compiling your digitale. With Power Point, you start by creating a picture aloum of the
pictures you wish to use in your story and the album is then turned into a slide show. After
this, the narration is recorded with the ‘record sound’ function in the software. The slide show
may be programmed to change slides automatically, which makes the slide show similar to
digitale. The Power Point file may be projected on a screen with a data projector as a Power
Point show, as well as saved on a CD. The limitation of the software is that you cannot
produce the film as a video file, meaning that it cannot be saved on a DVD.



MATERIAL

In digitale, you may use drawings, photographs, objects and music that are made or
composed by you or you have the right to use. Due to copyright reasons, you cannot copy
just any pictures or music from the Internet, CDs, books or magazines. However, there are
no limitations to composing your own music. In digitale in the Medios project, it is allowed to
use the music clips found in www.multimedia.skolverket.se/Arkiv/Musik/]. However, you
should mention this as a reference (the address for the site) in your final credits, as well as
the composer Karl Malbert.

CREATING FOLDERS

Once you have gathered the materials, you can create your own folder on your computer;
you can name the folder for example DigitalStorytelling_Own name. You can create more
folders inside the folder. ALL the material produced during the process is saved in these
folders.

Also check in advance that there is enough space on the hard disk for saving all the material.
The pictures, sound and potential music will take its space but so will the various versions of
the video, as well as the final AVI file (completed video). The space required varies quite a
bit, depending on for example the size and number of photographs. A video file that lasts for
three minutes and has many pictures and effects in it alone may take up to 600MB.

As the process progresses, always save the material in the right folder. Thus you will
maintain order and save precious time:
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the Sound folder.

- Copy digital photographs from your
camera, CD or flash drive into the
Pictures folder.

-> Scan pictures and drawings, etc. Save
them in the Pictures folder.

- If necessary, process the pictures with
image processing software and save
them in the Edited pictures folder.

- Save the film project in the My film
folder.

- Save the finished film in the Export

Other Places

e Removable Disk (Lix
() vy Documents
() Shared Documents

& My Computer

folder.

N.B! It is extremely important to save all the material in the same folders every time instead
of different folders; otherwise the files may easily go missing, especially if you for example
continue the project on a different computer. Movie Maker will remember where all the
information is saved and look for them in the same places. For example, if you save your
pictures on a flash drive and then remove the flash drive from the computer, the software will
not find the pictures later on and you will have to transfer the pictures again afterwards = not
a rare case.


http://www.multimedia.skolverket.se/Arkiv/Musik/

RECORDING THE VOICEOVER

The recording should be done one person at a time, in a soundproof room that does not echo
much. If necessary, the director may be present at the recording. In a way, the director will
act as an extra ear and instruct the narrator in using the equipment.

Recording sound with Windows Movie Maker:

- Tools -> narrate timeline

- Start narration

- Take a short silent pause at the beginning and at the end; this way you will get a “void”
on the audio track that has the same sound environment as during speech (noise,
etc.)

- When you finish talking, stop the recording and a save window will pop up

- You can go back to working on the timeline by clicking ‘done’.

- If you record the voiceover some other place than your own computer, save the
recorded voiceover on a flash drive. When you put the flash drive back into your own
computer, copy the sound clip to your own folder in order to keep the sound safe in
your own files. After this, go to Movie Maker > open own project > choose ‘import
sound from file’ and retrieve the sound from your own folder.

- N.B. If you already have pictures on the timeline, Movie Maker will only allow you to
record sound as long as there are pictures on the timeline; i.e. if the duration of the
pictures is 30 seconds and you try to record speech that lasts for a minute, the
recording will stop at 30 seconds. The sound cannot be longer in duration than the
pictures. Therefore it is better to record the sound before you place any pictures on the
timeline.

The sound may also be recorded with a separate recording device. This may be a digital
Dictaphone, MiniDisc or Zoom H2; a palm-sized sound recorder including a microphone.
Depending on the device, it either treats the sound as a file or as sound, meaning that you
can either transfer the sound to your computer by simply transferring the sound file or you
may have to “record” it again on your computer (just like you were recording ‘narrate timeline’
with a microphone, only now the sound would come from an external source).

When recording the voiceover, it is good to remember:

- Be careful not to rustle papers or to make any other noises. During the recording,
place the script for example on a music stand or tape it to the wall at eye level. If your
chin is clearly down during recording, it will affect your voice.

- Check that the microphone and flash drive/other recording device are connected and
all equipment found.

- Check sound levels. First do a trial reading and see that the sound does not go red,
i.e. “break” (input level).

- Check that you can hear the sound in your both ears through the earphones (stereo).
If not, check audio input (show more options) options or ask the person in charge of
the equipment to help you.

- Set the microphone at appropriate height. Take a good and steady position. When you
are ready, push the “start narration” button.



video

- After the recording, the recorded clip will appear automatically on the audio track of
the timeline. Press space or play on the monitor to listen to the voiceover. You can
delete the clip from the timeline without deleting it from the file/collections.

- N.B. The following applies to joint Movie Maker projects, where all group members
record voiceovers: Once you have recorded your own voiceover, delete the clip from
the timeline (delete). This does not delete the clip from the file. (This must be done
because, in case the clip is left on the timeline and the next person starts to record
their voiceover, the recording will only last as long as the previous clip on the timeline.
When a new person comes to record their voiceover, the timeline must be

empty.)
SCANNING PICTURES

When scanning, take into consideration:
- Always save the pictures in your own folder (300dpi)
- Make sure that the picture size/format is the same, e.g. 720x576.gif/jpeg

TRANSFERRING DIGITAL PICTURES

If you take more photographs, make sure that the camera is set on high resolution of
1600x1200 minimum. This way you can enlarge the picture without making it poorer in
guality. When you transfer the photographs from your camera to the computer via an USB
cable, first remember to copy the photographs in your folder (Pictures).

IMAGE PROCESSING SOFTWARE

With basic image processing software (Paint), you can process the pictures on a very
rudimentary level. Paint.NET allows you to do more. The software for example allows you to
crop your pictures again: From the Tools menu, activate “rectangle select” tool (dashed lines)
and crop the picture to your liking by dragging with the mouse. You can always undo the
selection by clicking on the picture once and then select a new area. When you are pleased
with the cropping, select “image” -> “crop to selection” from the top bar. You can also rotate
the picture clock-wise or reverse it as a mirror image with “Image” -> “flip” or “rotate”
selections. In the “Adjustments” -> “Brightness/Contrast” menu, you can lighten/darken the
image or adjust contrast. In the “Effects” menu you van add various visual effects in the
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picture, such as oil or pencil sketches and softening/crispening. If you wish to draw on the
picture, select “pencil” or “paintbrush” from the Tools menu. The color of the drawing is the
color square on top of the “colors” circle. Keep in mind the Edit->Undo command in case you
wish to undo the latest function.

Save the processed image under a new name (save as) in your own folder (Edited pictures).
This will make it easier to separate the edited pictures from the original ones, especially if
there are many pictures.

COMPILING DIGITALE
Once you have gathered the materials (scanned/taken pictures, processed the images,
recorded the voiceover) and saved it all in their own folders, you can move on to the

compiling stage.

Open Windows Movie Maker. File > open project > choose the project you have saved. If you
have not created a project yet, you can create it now:

- File > New project and save the project under a name into your My film folder as follows:
File — New Project — Save Project As

R _ @3 1 you wish, you can save more than one
sevein = Dane. B o el version of your project, 1, 2, 3, 4. Thus you
Minun elokuva . .
D B will create back-ups of your project. Instead
| e of simply clicking “save”, click “save as” and
@ o give the version a name, e.g.
Deskton DigitalStorytelling_JaneDoe 1,

DigitalStorytelling_JaneDoe 2, etc.

My Documents

On the left side of the editing software you

oL will find a menu that has three sections (1.
IRRRES Capture Video, 2. Edit Movie, 3. Finish
‘:) File name: Digitarina_kM aijameik alainen 1 V. MOVle), aS We” aS tlpS

w3
My Metwark Save as type: Windows Movie Maker Projects [“MSWM] -

In these sections you will find the options

you need to make your film. Small arrows on the right side of the heading will open/close
extended menus.

2. igitar fowrs Movie Maker

Your material (pictures and sound) will
be placed on the empty white area in
the middle (collections). The blue area
on the bottom is the timeline, where
the film is compiled. The black box on
the right is the monitor where you can
watch your film.

aaaaaaaa
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Import the material to Windows Movie Maker

1. Capture Video

Choose option Import pictures. Find the pictures you wish to import to Windows Movie Maker
in the folder. You can transfer the pictures one at a time or multiple pictures at a time by
clicking on the first file with the mouse, then pushing and holding down the Shift button until
you have clicked on the last file you wish to import with your mouse. By holding down the Citrl
button you can select multiple individual pictures. Push Import. Your pictures should appear
in the collections area in the middle of the frame.

In order to import the voiceover from your file, select Import audio or music. Find the file and
press Import.

- You can also capture video images from the video camera (capture from video
device). Make sure that the device is connected and that the computer recognizes the
device before you start capturing.

- You can also import a completed video clip from your files (Import video)

Compile the film on the timeline

You can view the timeline in two different ways by selecting Show Storyboard or Show
Timeline from the box above the timeline. On the left you can see the video, audio and text
tracks. Select Show Timeline when you wish to import pictures and sound to the timeline.
Drag the pictures/sound on the timeline one at a time. The picture will be automatically
placed on the picture track and the sound on the audio track. (Click the picture with the left
button of the mouse, hold the button down and drag the picture onto the timeline. Let go of
the mouse.)

You can change the order of the pictures on the timeline by clicking on the picture and
dragging it to the desired spot. After you have clicked on the picture, the arrow will turn into a
hand (N.B. the red horizontal arrow stretches the clip instead of moving it). Before letting go
of the mouse button, the blue cursor will show you where the picture has been dragged.

Fle Edt Wew Took dClip Play Help
B Tasks | [ Collections | [ Collections v =

S Collection: Collections
e || Drag a clip and drop it on the timeline below.

2. Edit Movie [©) Elue hils Sunset

3. Finish Movie ®

(OB (6ie) (@)

L 04 (») | T show starvboard
000 0007000  Qp02000 0003000 0004000 000%000  GOT0000  GO7T1000 0072000 0013000 0014000 0015000 0020000 0021000 0022000 0023000 0024000

AudiofMusic

Tile Gverlay |
< >

Ready
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N.B. If you move the picture to the left, toward the picture next to it, you can see a blue,
narrow bar appearing in the picture. This bar refers to a cross-cut. The cross-section of the
two images will be softened with a cross-fade. If the purpose was to skip over an image or
two and change their places instead of cross-cut, press ctrl + z or edit -> undo.

If the hand over the picture turns into a red double arrow, you can lengthen or shorten the
duration of the image by stretching the clip.

Remember to save your project on regular intervals during work! (ctrl + s)

Once you have imported the pictures and the sound to the timeline, you can pace the
duration of the pictures to match the voiceover.

In order to watch the film, press the play button above the timeline. The blue cursor will show
you where you are in the film in relation to the duration. You can move the cursor on the
timeline by clicking on the blue box on top of the cursor. You can move the cursor to any
point in the movie and start watching at a desired spot.

2. Edit movie
Titles

You should add the title of the film at the early stages of editing since it will move the picture
clips on the timeline forward, thus moving them to the wrong place in relation to the audio
track. Select Make titles or credits form the menu on the left. Select Add title at the beginning
of the movie for the opening credits. Write the text. The text will appear on the monitor on the
right.

Select Change the text font and color in order the change the type or color of the font, or to
change the color of the background. Change the title animation will change the way the title
appears on the screen. When you are pleased with the title, click Done, add title to movie.
You can easily edit the text again by double-clicking the text clip on the timeline.

wwwwwwwww

(DD OIOD O®)

The timeline has a text track for you to create text that is shown over a picture, at the same
time. If you wish to do this, select the text tool add title on the selected clip. Thus the text
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will appear on the timeline in its own Title overlay text track. You can move the text clip
similarly to pictures and sound.

Remember to use the right button of the mouse when you want to make changes, it is useful
both with titles and other clips.

Once you have placed to pictures on their right spots and you have edited the duration of the
pictures to match the pace of the story, you are almost finished. If you wish, you can add
transitions or effects to change the outlook of the film.

View video transitions/view video effects -> Roll down the effects and select for example
Fade. Drag this effect on the timeline over the picture.

You can also try other transitions but it is good to consider in advance the kind of media the
film will be presented in. For example, many transitions and effects do not work as well in
films that are shown online on the internet.

. Untitled - Windows Movie Maker
Fle Edt Wew Took Cip Play Help
[B Tasks |17 Collctions | k- video Effects ) = | E-

| Video Effects
|| Draga video effect and chop it on & video ciip on the timeline below.

=i e 1
— _ [—]
2. Edit Movie L:‘" Blur Erightriess, Decrease Erightness, Increase
Show collections.
View video krsnsitions m m
Make titles or credits e e
3. Finish Movie [©]
Movie Making Tips (@) Ease In Ease Out Fade In, From Black
%)
Fade In, From YWhite Fade Out, To Black Fade Out, To white
g 1 |
- g | S 54 |
B A2 % 2 04 I show Steryboard

pooo o Dn‘m o0 OfpOt0 0005000 D004030 000 S000 0010000 0011000 0012000 0013000 0014000 0015000 0020000 0021000 0022000 0023000 0024000

AudiofMusic

Title Overlay
3 >

Ready

Working on sound in the timeline
By clicking on the sound clip on the timeline with the right button on the mouse, you can enter
a menu through which you can add opening or end fade

ins/outs and adjust volume levels (audio clip volume). You Audio Llip.Jelume X
can cut the audio clip by using the “clip” -> “split” function in o st volme evel . LK

the top menu. The sound file must be active on the timeline | == y
and the cursor on the place you wish to cut the sound clip .

on. This way you can for example edit out long, silent Rt

moments or add silent moments. The same cutting function
can also be used with video picture. By clicking on the right button over the sound clip, you
can for example adjust volume levels.
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COMPLETE FILM

Before you save your film for the last time, make sure there are not any extra clips you have
removed at the end of the timeline! They will be included in the final version if you have only
moved them forward on the timeline, waiting for potential use.

3. Finish movie

Once you have completed the film, select section 3. Finish movie in Movie Maker. Select
Save to my computer > Saved movie file > My computer, next > Name your film, e.g.
Maijameikalainen_Kesamokki > Save in your folder.

Save Movie Wizard E] Save Movie Wizard @
Saved Movie File ,(‘!;\‘ Movie Selting f;‘!’\-l
Enter information for your saved mavie file. “i. Select the setting you want to use to save your movie. The setting pou select '\!.‘
detemmines the quality and file size of your saved movie.
1. Enker a file name For your saved movie. () Best quality For playback on my computer (recommendsd)
| Maijameikalainen_kesamakdd| (O Best it ta file size: | i i

() Other settings: Hi-;h quality video {large)

2. Qﬁoose a place ko save your movie, e

|| Li\Digitarina_Oma nimilExport b

Setting details Mavie file size

File bype: Windows Media Yideo (WM The movie File size will vary based on the
Bit rate: Yariable bit rate content of the saved mavie,

Display size: 640 x 480 pixels

Aspect ratio: 413 Estimated disk space available on drive L:
Frames per second: 25 94,00 MB

[ < Back H Mest > I[ Cancel I

< Back ” Mest > ][ Cancel

Saving options (depending on the purpose of use):

DV-AVI (Pal) > If you wish to make your film into e.g. a high-quality DVD/also suited for
online publishing

WMV (High) (High quality video, large file) > For online publishing

WMV (Small) (Small quality video, small file) > For saving on e.g. a flash drive/e-mail

The saving options can be found in the Movie setting menu > Other settings: roll down to the
desired place.

VIEWING THE FILMS AND GIVING FEEDBACK

An important part of digitale is watching the completed stories together. Then it is good to
discuss how making the film felt, what the filmmaker experienced during/after the process
and how they feel about the outcome. If possible, the filmmakers can also invite family
members and friends to the viewing. Thus it must be asked from each filmmaker whether
they allow their work to be presented in public.

Excellent! Now you have finished your personal digital story!
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IN CASE EQUIPMENT IS MISSING

If you do not have access to a scanner, you can photograph paper pictures with a digital
camera or take topic-related pictures in digital form. You can also draw the pictures.

If you do not have access to a microphone, you can add subtitles to the film.
If you do not have access to a digital camera, you can use a scanner. Only creativity is the
limit!

COPYRIGHT

Only pictures taken by the filmmaker or pictures they have the right to use can be used in the
project. All music and sound material used must be composed by the filmmaker themselves,
or be free of copyright. Commercial music cannot be used, since it is always required to pay
royalties to the holder of the copyright. Copyright online (in Finnish):
http://www.finlex.fi/fi/laki/ajantasa/1961/19610404]

ON PICTURE FORMATS

If you take your photographs with a digital camera, the camera will save them in jpeg format.
In order to prevent from losing picture information, the picture format should be kept the
same when importing the pictures to the editing software. If you want to edit the photographs
you have taken with a digital camera in image processing software, you should save the
pictures in the same jpeg format.

If you want to scan your pictures and/or edit them all in image processing software, you can
also save them in gif format, which is a bit better in relation to compressing the pictures than

jpeg.

It is okay even if your digital photographs were in different formats when you transferred them
to the editing software. When you export the film, it will be compressed again to a format of
your choice (AVI, WMA).

The only precondition is that the editing software supports the picture / sound formats you are
importing in the software. The software will let you know if the format is not supported. Gif
and jpeg are well-supported formats.

Picture formats used at the moment in the Internet are gif and jpeg (jpg), which are based on
bit-map graphics. The browser is unable to show other formats. (Of course, this does not
apply to the finished film which will be compressed to a new format when exported (AVI,
WMA)).

Gif

The compression algorithm LZW used by the gif format does not lose information from the
picture; instead, the compressed picture is of equal quality to the original. Gif format should
be used in line drawings, types and pattern pictures. It is not good for colorful photographs or
strongly shadowed pictures as they have plenty of changes in shade. Since gif pictures can
have 256 colors at the maximum, photographs (having millions of colors in them) will screen
to poor-quality versions when turned into gif format.
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Jpeg

Unlike gif pictures, the compression algorithm JPEG DCT (Discrete Cosine Transform) used
in jpeg saving loses information. When saved in jpeg format, the smallest details are
removed from the pictures, which allows the pictures to be compressed extremely efficiently.
This enables putting even large pictures on Internet sites. Jpeg always saves pictures in
maximum amount of color (24-bit / app. 16 million colors). On screen the pictures will show
as well as the viewer’s equipment allows. The jpeg format is good for saving large
photographs and realistic pictures but not very good for small pictures and line drawings.

You can define the compression power in jpeg format yourself; the higher the compression
power, the smaller the file size will be compressed and the faster the picture will be uploaded.
However, at the same time more information is lost from the picture. l.e. as the compression
level grows, the picture quality will be reduced, and correspondingly the size of the picture file
becomes smaller. However, information is first lost in places where it is too small for the
human eye to see. Only when the picture is significantly enlarged, the “lost points” will show.
The optimal relationship between the size and quality of the picture file is found by
experimenting.

The picture quality is weakened every time it is saved from the image processing software
using jpeg compression. It should only be used in saving fully completed images.

ON SOUND FORMATS

The sound format most often supported by computers is basic form, uncompressed digital
sound. The file may be saved in various sampling frequencies (11 kHz, 22 kHz, 44 kHz, 48
kHz) with various bit resolutions (8-bit, 16-bit) either in mono or stereo sound.

The earliest Internet browsers also first supported linear sound formats. In order to hear
linear sound, the user did not have to download any “extra” plug-in utility programs on their
browser. The general formats for digitalized sound in Internet sites have been wav and au
formats. Nowadays compressed sound formats have replaced linear audio in the Internet.

Compressed sound formats:

WMA

Windows Media File.

This compressed file format ending in wmf is Microsoft’s rival to RealMedia. In relation to
sound, Windows media is based on the same kind of psycho-acoustic compression as
RealMedia. In order to function, WMA requires Windows Media Player.

MP3

Mpeg 1 Layer 3 Audio.

This file format ending in mp3 is a subtype for the world-wide MPEG (Motion Picture Expert
Group) standard. For example MiniDisc players and digital radio (DAB) and television (DVB)
transmissions use MPEG standards (or its commercial applications). Also, picture and sound
compression in DVDs follows the principles of the MPEG standard.

Listening to MP3 compressed music requires its own plug-in utility program. As the MPEG

standard is open, there are dozens of plug-in programs. RealMedia and Windows Media
Player can also reproduce MP3 compressed sound.
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Linear sound formats:

WAVE

Waveform Audio File Format.

This file format ending in wav is a sound format originally developed by Microsoft and IBM for
Windows 3.1 operating system. Wav sounds are a Windows standard and therefore the most
common audio file format.

AlIFF, AU, MIDI

If the audio file cannot be opened in the editing software:

E.g. music file on a CD
- You can for example use the CD-DA-X-Tractor software (free software in the
Internet) with which you can convert the audio file into another format.

Glossary:

dpi (/ppi) = “dots per inch”. The number of dots affects the resolution of the picture, i.e. the
quality. The more there are dots, the sharper the picture will seem and details will be visible.
72dpi is usually enough for pictures on a computer screen, 300dpi is recommended for high-
quality printing. This can also be called “pixels per inch”, or ppi.

resolution = Refers to the sharpness of the picture; the unit of measurement is usually
dots/pixels per inch: dpi or ppi.

crop = A term used in image processing when a picture is re-cropped.

fade = Video picture may for example be faded out, i.e. the picture will slowly fade to black.
At the beginning, the picture may be faded in, meaning the picture will slowly arise from the
black. Fade can also be used for sound or still images.

rotate = rotates the still picture to the desired extent or 90 degrees clockwise or anti-
clockwise. With this command you can turn horizontal pictures that are the wrong side out to
a vertical position and vice versa.

VO, voice off/over = The narrator’s / speaker’s voice is attached to the picture separately; the
speaker is not visible and something else is happening on screen instead.

transition = In editing, the manner with which it is moved from one picture to another, e.g.
cross-cutting or an effect.
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